K4100 Desktop Label Printer
**Introduction**

**Kroy Limited Warranty**

Kroy LLC ("Kroy") warrants its labeling system equipment against defects in material and workmanship for a period of six (6) months from the date of purchase. At no charge to the customer except for inbound freight to Kroy's service center, Kroy will, at Kroy's option, repair or replace any product determined to be defective. Kroy will pay return UPS ground charges. A purchase receipt or other evidence of purchase will be required before warranty service is rendered. This warranty does not cover cosmetic damage or any damage caused by accident, misuse, abuse, negligence or modification or attempted repair by anyone other than Kroy or a Kroy authorized repair agent. **THERE ARE NO EXPRESS WARRANTIES EXCEPT AS SET FORTH IN THIS PARAGRAPH.**

KROY SHALL NOT BE LIABLE FOR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR BREACH OF ANY EXPRESS OR IMPLIED WARRANTY ON THIS PRODUCT. ALL EXPRESS AND IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO THE APPLICABLE WARRANTY PERIOD SET FORTH ABOVE.

Some states do not allow the exclusion or limitation of incidental or consequential damages, or limitations on how long an implied warranty lasts, so the above exclusions or limitations may not apply to you. This warranty gives you specific legal rights, and you may have other rights which vary from state to state.

If a problem develops with your Kroy labeling system during or after this warranty period, you may contact Kroy customer service at 800.729.5769.

**FCC Notice**

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Any changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

**CDC Notice**

This digital apparatus does not exceed Class A limits for radio noise for digital devices as set out in the radio interference regulations of the Canadian Department of Communications.

**Battery and AC Adapter Notice**

This product is intended to be supplied by a Listed Power Unit AC adapter rated 12V DC, minimum 4.0A.

CAUTION: (for Lithium Battery) Risk of explosion if battery is replaced by an incorrect type. Dispose of used batteries according to the manufacturer’s instructions.

The K4100 Printer and Cartridges are protected by U.S. Patents including: 5,411,339  5,533,818
Table of Contents

Chapter 1: Getting Started
Contents of Box................................................................................................ 3
Printer Description............................................................................................ 4
Important Safety Precautions........................................................................... 5
Connecting AC Adapter.................................................................................... 6
Installing the Supply Cartridge.......................................................................... 7

Chapter 2: Printing Your First Label
Printing a Label................................................................................................ 9
Turning Printer On............................................................................................ 9
Cursor Movement............................................................................................. 9
Default Printer Settings.................................................................................... 9
Editing Text...................................................................................................... 10
Adding a Character Style................................................................................ 10
Printing on Shrink Tube................................................................................... 11
Printing a Self-Laminating Wire Wrap............................................................. 12
Frequently Used Keys..................................................................................... 13

Chapter 3: Operating Your Printer
Font Function...................................................................................................15
Size Function...................................................................................................16
Character Styles- .......................................................................................17-18
  Bold, Italic, Underline
Other Styles - .............................................................................................19-21
  Mirror, Frame, Justify, Vertical, Rotate
Label Setup.................................................................................................22-23
  Length, Cutmark, Left Margin, Vertical Margin
Shortcuts and Hot Keys..................................................................................24
Multiple Copies & Sequencing......................................................................25-30
Printer Setup...............................................................................................31-32
  Reset, Unit of Measure, Density, Auto Off, Advance Cut,
  Language,Printspeed, LCD Contrast
Bar Codes....................................................................................................33-34
File Management.........................................................................................35-36
  New , Open, Save, Delete
Multiple Page Documents............................................................................... 37
Time/Date Stamp.......................................................................................... 38-39

Chapter 4: PC Operations
Introduction...................................................................................................... 41
KLDS Software and Driver Installation............................................................ 42
KLDS Operation..........................................................................................43-44
Downloading Fonts.....................................................................................45-46
Appendices

Maintaining Your Printer................................................................. A-1
System Messages......................................................................... B-1
Troubleshooting......................................................................... C-1
Updating Printer Firmware......................................................... D-1 D-2
Using Accent Characters............................................................... E-1
Using the Character Map ............................................................. F-1
Getting Started
(1) K4100 Desktop Label Printer

(1) Owner’s Manual and (1) CD-ROM with KLDS Software and Drivers

(1) AC Adapter with Power Cord

(1) Serial Cable
Figure 1: Top View of Printer

- Tape Compartment
- Print Key
- LCD Display
- Delete/Escape Key
- Enter Key
- Cursor Keys
- Power Key
- Function Keys
- Cutter

Figure 2: Back View of Printer

- Serial Port
- AC Adapter Jack
- Power Key
- Print Key
- Curtain Keys
- LCD Display
Important Safety Precautions

When using your printer, always follow these important safety precautions:

1. Read all instructions carefully.
2. Do not immerse the printer in water or other liquids, you could receive an electrical shock.
3. Do not apply adhesive labels to your skin.
4. Do not put objects onto or into the printer.
5. Do not expose to high temperatures or high humidity. Never leave on the dashboard or in the trunk of your car.
6. Do not use in dusty places and avoid direct exposure to sunlight and rain.
7. Do not pull on the tape, you could damage the tape cartridge.
8. Do not attempt internal repairs to the printer. If service or repair is needed, contact a qualified Kroy service representative.
9. Do not touch the printhead ceramic or rollers with your fingers.
Connecting AC Adapter

The AC adapter is required to power the K4100. **Warning: Only use the AC adapter provided with this machine. Use of any other AC adapter will damage your K4100, make it unusable and void the warranty.**

**Connecting the AC Adapter**

1. Insert the AC adapter plug into the AC adapter jack on the back of the machine (See Figure 3).
2. Plug the other end of the AC adapter into the nearest standard electrical outlet.

---

**Figure 3: AC Adapter Connection**

![Figure 3: AC Adapter Connection](image)

**WARNING:** K2500, K3000-PC and K240 AC adapters are NOT compatible with the K4100.
1. Wind the ribbon spool on the bottom of the supply cartridge counter-clockwise two full turns in the direction of the arrow with your finger.
2. Insert cartridge into the cartridge cavity with the lock/release knob turned counter-clockwise and the excess material threaded in the exit slot.
3. Turn the lock/release knob clockwise to lock the cartridge into place.
4. Press **FEED** and you are ready to create a label.
Printing Your First Label
After you have connected the AC adapter, plugged the AC adapter into the nearest outlet and installed the label cartridge, you are ready to make your first label.

**Turning the Printer On**
Press the **Power** key located on the front left corner of the keyboard to turn the printer on. The following displays will appear:

Kroy K4100
Version 1.0A

1: 
2: 

**Cursor Movement**
The underline seen above is the cursor. The cursor shows you the current typing position. *Cursor* keys move the cursor through text without changing it and through options without selecting any. The left and right cursor keys move left and right, one option or one character at a time; the up and down cursor keys move the cursor up and down through lines of text, one line at a time.

**Default Printer Settings**
When the power is turned on for the first time, there are pre-programmed printer settings. One of these is the **Auto Size** feature. This feature auto sizes the text of your label to the current cartridge supply and size of media. You can find this function by pressing the **Size** key. You can always turn auto sizing off and type in a designated size, but for our example we will have auto sizing ON. The default font is “Block”. No other font is installed on your K4100, however, other fonts of your choice can be downloaded into your K4100. The default justification is left. For more information on formatting and label setup see Chapter 3.

In the following examples, we have kept the default settings ON.

Type in the text “Cable 2E45”

1: Cable 2E45
2: 

Now that your label is typed, you will press the **Print** Key and the auto sizing feature automatically sizes the text for the cartridge you are using.

Cable 2E45
To make a two line label, press **Enter** at the end of line 1 and you will see the cursor go to line 2. Type in the text “Floor 2C” on line 2.

```
1: Cable 2E45_
2: Floor 2C_
```

Now that you have two lines typed, press the **Print** key and the auto sizing feature automatically sizes the two lines for you.

```
Cable 2E45
Floor 2C
```

To add additional lines, perform the same function again.

**Editing Text**

You can correct or change characters by using the left and right cursor keys to move the cursor to the right of the character to be changed. Use the **Delete** key to delete the character and type in the correction. Below we changed the “E” on line 1 to “F” in our example.

Move the cursor to the right of “E” on line 1, press the **Delete** key and type in the letter “F”.

```
1: Cable 2E45
2: Floor 2C
```

**Adding a Character Style**

You can change the style of text previously entered by using the left and right cursor keys to position the cursor to the beginning of your text. Press the **Style** key to select your character style of choice. To turn styles on and off use your **Enter** key.

In the following example, the cursor is moved to the beginning of the word “Floor” and **Bold** was then selected in the **Style** Menu. *Note: Only text to the right of the cursor will be changed.*

```
1: Cable 2F45
2: Floor 2C
```

Now that your label has been edited and styled press the **Print** Key.

```
Cable 2F45
Floor 2C
```
Printing on Shrink Tube

Kroy offers flattened shrink tube cartridges for wire marking. Insert a shrink tube cartridge for this example.

You will start with a New file. To create a New file, press the File key and select New with the Enter key. Or use Shift and File as a shortcut.

For our example, we kept Auto Size ON.

Type in the following text “File Server”

1: File Server
2:

Press the Print key. Cut the shrink tube label and insert the wire.

The tubing can be shrunk around the wire with a heat gun.

For further information on formatting the text of your shrink tube See Chapter 3.
Kroy offers self-laminating wire wrap cartridges ideal for marking terminated wires and cables. Insert a self-laminating wire wrap cartridge for this example.

For our example, we kept Auto Size ON.

You will start with a New file. To create a New file, press the File key and select New with the Enter key. Or use Shift and File as a shortcut. When using a wire wrap cartridge, this will activate the automatic rotation feature. Rotation is necessary because the printable area of a wire wrap is vertical and represents a small portion of the label.

Type in the following text “300E”

```
1: 300E_
2: 
```

Press the Print key then Feed and you have a wire wrap ready to apply.

Apply the printed portion of the label to your wire and wrap the laminated tail around the wire.

For further information on formatting the text of your wire wrap See Chapter 3.
The keyboard is used to enter label text and access menus. You will hear an audible click whenever a key is depressed. The frequently used keys on the keyboard are described below.

**Function keys** (File, Font, Size, Style, Repeat), will automatically prompt a list of selections to choose from. When using some function keys, the printer will display submenus or prompt you for information. These function keys also act as “toggles” which allow you to turn an option on or off.

The **Alt Key** accesses special character symbols shown in blue on particular keys. To enter a special character, (such as Å), hold down **ALT** and press the key of choice at the same time. To abort a print job, use the **Alt** and the **Print** keys together.

The **Cursor (Arrow) Keys** move the cursor through text without changing it and through options without selecting any. The left and right **Cursor** keys move left and right, one option or one character at a time; the up and down **Cursor** keys move up and down through lines of text, one line at a time. When used with **SHIFT**, the up and down **Cursor** keys act as **Page up** (previous label) and **Page Down** (next label) keys and the left and right **Cursor** keys move the cursor one word at a time.

The **Caps Key** locks capital letters on. Pressing the **Caps** key again turns off the function. The **Caps** key does not effect the number keys.

The **Delete Key** allows you to cancel functions or escape from menus. **Delete** erases characters to the left of the cursor. To **Delete** an entire line, hold down **Shift** and the **Delete** key together.

The **Enter Key** in typing mode, moves the text or the cursor to the next line. In function mode, the **Enter** key selects specific menu options, file names and default printer settings.

The **Feed Key** advances the tape from the printer.

The **Print Key** prints the current label and advances the tape far enough to clear the cut mechanism.

The **Shift Key** capitalizes individual letters and accesses the black characters on the number keys (such as !). Using the **Shift** and **File** key creates it clears text allowing you to create a new label.
Operating Your Printer
Font Function

Using the Font Menu
When you select the Font key the printer displays the default “Block” font seen below. *This is the only font included with the K4100.*

![Font Menu](block)

K4100 has the *option* of downloading fonts from your PC. When you download a font, it will be added to your Font menu.

![Font Menu](block_times_arial)

Press **Enter** to accept the current Block font or use the left and right cursor keys to move the cursor to the left of the font you want and press **Enter** to select it.

See **Downloading Fonts** on **Pages 41-42** for further information.
Using the Size Menu

Select **Size** to specify the print size for your text. The printer displays the default **Auto Size** function and waits for your entry. Press **Delete** to accept auto sizing or type a different size and press **Enter**. Valid sizes of 4-72 pt can be entered.

<table>
<thead>
<tr>
<th>Size Menu</th>
<th>Auto Size OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size ▶ 24</td>
<td>*Auto</td>
</tr>
</tbody>
</table>

When printing, the K4100 will show what point size is being printed in the auto size mode. See below.

| Printing..... | Auto Size xx pt |

If you select **Auto Size**, the K4100 will automatically adjust the print size based on the number of lines of your label and the width of the label media. If you turn auto size off, the size of the print you select must take into account the number of lines of your label and the width of the media.

<table>
<thead>
<tr>
<th>Error</th>
<th>Size Too Small</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If auto size calculates a point size smaller than 4 point, an error message will be displayed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error</th>
<th>FontSize Too Big</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the text you have typed is too large, an error message will be displayed.</td>
</tr>
</tbody>
</table>

See the table below which can be used as a guide. The table assumes using characters of all the same size (capital letters). When using characters of varying size (such as lower case letters or accent characters) or using character styles (such as bold, italic etc.) the maximum point sizes will vary slightly.

<table>
<thead>
<tr>
<th>Tape Size</th>
<th>1 Line</th>
<th>2 Line</th>
<th>3 Line</th>
<th>4 Line</th>
<th>5 Line</th>
<th>6 Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.375”</td>
<td>28 pt</td>
<td>11 pt</td>
<td>8 pt</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>0.50”</td>
<td>38 pt</td>
<td>19 pt</td>
<td>12 pt</td>
<td>8 pt</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>0.80”</td>
<td>60 pt</td>
<td>30 pt</td>
<td>20 pt</td>
<td>15 pt</td>
<td>11 pt</td>
<td>N/A</td>
</tr>
<tr>
<td>1”</td>
<td>72 pt</td>
<td>36 pt</td>
<td>24 pt</td>
<td>18 pt</td>
<td>14 pt</td>
<td>12 pt</td>
</tr>
</tbody>
</table>
Character Styles

This section explains how to use the Style key to assign text formatting attributes to your label text. There are three types of text attributes: character, line and page. These attributes, as well as their defaults and options, are shown in the following table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Defaults</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Block</td>
<td>Download True Type Fonts from PC</td>
</tr>
<tr>
<td>Size</td>
<td>Auto Size On</td>
<td>.50” 4-30 point size .80” 4-55 point size 1” 4-72 point size</td>
</tr>
<tr>
<td>Justification</td>
<td>Left</td>
<td>Left, Center, Right</td>
</tr>
<tr>
<td>*Bold</td>
<td>Off</td>
<td>On, Off</td>
</tr>
<tr>
<td>*Italic</td>
<td>Off</td>
<td>On, Off</td>
</tr>
<tr>
<td>*Mirror †</td>
<td>Off</td>
<td>On, Off</td>
</tr>
<tr>
<td>*Vertical †</td>
<td>Off</td>
<td>On, Off</td>
</tr>
<tr>
<td>*Frame</td>
<td>Off</td>
<td>Page: On, Off</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Line: On, Off</td>
</tr>
<tr>
<td>*Underline</td>
<td>Off</td>
<td>On, Off</td>
</tr>
<tr>
<td>Rotate †</td>
<td>Off</td>
<td>On, Off</td>
</tr>
</tbody>
</table>

* Attributes marked with a asterisk are toggles. † are line attributes. They affect the entire line of text that the cursor is positioned on. ‡ are page attributes. They affect the entire page (label). All other attributes (except Frame) are character attributes only and affect the text from the point that the cursor is positioned.

The following style settings are available on the K4100: Rotate, Bold, Italic, Underline, Justify, Mirror, Frame and Vertical.

To Select Multiple Styles, with less keystrokes, use the Space Bar and the cursor keys to turn styles on and off. For more Shortcuts, See page 24.

Note: When the Style menu is selected, all selections are not visible on the LCD display - you will have to use your left and right cursor keys to scroll through all the choices.
The most common character styles used are **Bold**, *Italic* and *Underline*.

To emphasize the text of your label using **Bold**, move the cursor to the position where you want to apply the **Bold** attribute and press the **Style** key. Use the left and right cursor keys to move the cursor to the left of **Bold** and press **Enter**. When turned on, an asterisk will appear. To turn **Bold** off, press **Enter** again or to exit press **Delete**.

**Bold Example:**

![Style Menu]

```
1: ATTENTION
2:     
```

To italicize the text of your label using *Italic*, move the cursor to the position where you want to apply the *Italic* attribute and press the **Style** key. Use the left and right cursor keys to move the cursor to the left of *Italic* and press **Enter**. When turned on, an asterisk will appear. To turn *Italic* off, press **Enter** again or to exit press **Delete**.

**Italic Example:**

![Style Menu]

```
1: ATTENTION
2:     
```

To underline the text of your label using *Underline*, move the cursor to the position where you want to apply the *Underline* attribute and press the **Style** key. Use the left and right cursor keys to move the cursor to the left of *Underline* and press **Enter**. When turned on, an asterisk will appear. To turn *Underline* off, press **Enter** again or to exit press **Delete**.

**Underline Example:**

![Style Menu]

```
1: ATTENTION
2:     
```

18
Other character styles include Mirror, Frame, Justify, Vertical and Rotate.

To reverse the text of your label using **Mirror** press the **Style** key. Use the left and right cursor keys to move the cursor to the left of **Mirror** and press **Enter**. When turned on, an asterisk will appear. To turn **Mirror** off press **Enter** again or to exit press **Delete**. When using mirror image, use clear tape for best results.

```
1: ATTENTION
2: 
```

**Mirror Example:**

```
ATTENTION
```

To draw a box around the text of your label using **Frame** press the **Style** key. Use the left and right cursor keys to move the cursor to the left of **Frame** and press **Enter**. When turned on, an asterisk will appear. The printer displays the frame menu and waits for you to select the type of frame you want. To turn **Frame** off, press **Enter** again or to exit press **Delete**.

```
Style Menu
_Mirror _Frame
```

Once **Frame** is selected, the **Frame Menu** will appear. To frame all the text on the label, select **Page** by pressing the **Enter** key. When turned on, an asterisk will appear

```
1: ATTENTION
2: EMPLOYEES
```

**Page Frame Example:**

```
ATTENTION
EMPLOYEES
```
To frame just a line of text, move the cursor to the line of your text and select **Line** by pressing the **Enter** key. When turned on, an asterisk will appear.

![Frame Menu](image)

**Frame Menu Example:**

```
ATTENTION
EMPLOYEES
```

To justify the text of your label using **Justify** press the **Style** key. Use the left and right cursor keys to move the cursor to the left of **Justify** and press **Enter**. The printer displays the justify menu and waits for you to select the justification of your choice. To exit the **Justify** menu press **Enter** or the **Delete** key. **Note:** The default justification is left.

![Justify Menu](image)

**Justify Menu Example:**

```
1: ATTENTION
2: PLEASE
```

**Left Justification**

```
ATTENTION
PLEASE
```

**Center Justification**

```
ATTENTION
PLEASE
```

**Right Justification**

```
ATTENTION
PLEASE
```
To print the text of your label vertically instead of horizontally using **Vertical**, press the **Style** key. Use the left and right cursor keys to move the cursor to the left of **Vertical** and press **Enter**. When turned on, an asterisk will appear. To turn **Vertical** off press **Enter** again or to exit press **Delete**.

Vertical Example:

```
<ABCDEFGHIJKLMNOPQRSTUVWXYZ
```

To rotate the text of your label using **Rotate**, press the **Style** key. Use the left and right cursor keys to move the cursor to the left of **Rotate** and press **Enter**. When turned on, an asterisk will appear. To turn **Rotate** off, press **Enter** again or to exit press **Delete**.

*Rotation and Vertical are not the same. Note: Mirror is ignored when rotation is selected.*

Rotate Example:

```
300E
```

**Auto Rotation**

When a self-laminating wire wrap cartridge is installed, the K4100 will automatically rotate and auto size the text using the instructions below.

You will start with a **New** file. To create a **New** file, press the **File** key and select **New** with the **Enter** key. Or use **Shift** and **File** as a shortcut. This will **activate** the auto rotation feature.
To select the **Label Setup** press the **Shift** and the **Style** key together. The prompt below will appear. The menu options are length, cutmark, left margin and vertical margin.

```
Label Setup
■ Length _Cutmark
```

In the default setting, the **Length** of a printed label automatically adjusts to fit the length of text. If you want to specify the length of a label, the **Length** function allows you to set the length between 0.3” and 20”. To turn **Auto** off, type in your specific length and press **Enter**. To turn **Auto** on, press **Enter** again or to exit the menu without making any changes press **Delete**.

```
Length Menu
Len■ 0.3  *Auto
```

The **Cutmark** function creates cutmarks along a print job. Use the left and right cursor keys to move the cursor to the left of **Cutmark** and press **Enter**. When turned on, an asterisk will appear. To turn **Cutmark** off press **Enter** again or to exit the menu without making any changes press **Delete**.

```
Label Setup
■ Length *Cutmark
```

The **Left margin** function allows you to increase the size of your left margin by moving text from the left to the right of your label. The amount is measured in pixels. Use the left and right cursor keys to move the cursor to the left of **Leftmargin** and press **Enter**. A prompt will appear. Use the right and left cursor keys to select an increment up to 30 pixels. Press **Enter** to select the increment of choice. See the example below.

*This function is used with die cut labels and self-laminating wire wraps only.*

```
Room 5  Room 6
Floor 2C  Floor 2C
```

The text seen here has printed right to the edge.

```
Room 5  Room 6
Floor 2C  Floor 2C
```

The text is now adjusted.
The **Vertical margin** function allows you to move text from the top to the bottom by pixel on your label. Use the left and right cursor keys to move the cursor to the left of **Vertmargin** and press **Enter**. A prompt will appear below. Use the right and left cursor key to select an increment up to 30 pixels. Press **Enter** to select the increment of choice. See the example below.

The text seen here has printed to the bottom of the label.

The text is now adjusted upward on the label.
Shortcuts and Hot Keys

A Shortcut will provide a direct route to some submenus and options. See the listing below. To use a shortcut, first press and hold the Shift or Alt key and then press the second key.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + File</td>
<td>Creates a New File / Erases All Text</td>
</tr>
<tr>
<td>Shift + Font</td>
<td>Bar Code Menu</td>
</tr>
<tr>
<td>Shift + Size</td>
<td>Toggle Auto Size On/Off</td>
</tr>
<tr>
<td>Shift + Style</td>
<td>Label Setup</td>
</tr>
<tr>
<td>Alt + Style</td>
<td>All Styles Reset</td>
</tr>
<tr>
<td>Shift + Repeat</td>
<td>Time/Date Menu</td>
</tr>
<tr>
<td>Shift + Print</td>
<td>Printer Setup</td>
</tr>
<tr>
<td>Alt + Print</td>
<td>Stops Print Job</td>
</tr>
<tr>
<td>Shift + Delete</td>
<td>Erase Current Line</td>
</tr>
</tbody>
</table>

The Space Bar can be used to select multiple items on a menu. For example, in the Style Menu, if you want Bold and Italic on at the same time simply use your cursor key and the Space Bar to select these options and then exit the menu using the Delete key.

Hot keys are represented by a capitalized letter in most function key menus (i.e. _New _Open _Save). For example, the File Menu is selected. By pressing the letter “N”, a new file will be selected without using the cursor keys and the enter key. Hot keys turn menu options on and off. And they also act as a shortcut to submenus. Note: The function key must be selected first before using the hot key. Hot keys work only in function mode.

Below is a listing of some of the function menu’s hot keys.

**File Menu Hot Keys**

- “N” New File
- “O” Open File Menu
- “S” Save File Menu

**Size Menu Hot Keys**

- “A” Auto Size On/Off

**Style Menu Hot Keys**

- “R” Rotate On/Off
- “B” Bold On/Off
- “I” Italic On/Off
- “U” Underline On/Off

**Repeat Menu Hot Keys**

- “S” Sequence Menu
- “I” Insert
- “A” Alpha On/Off - Sequence Start/End
- “N” Numeric On/Off - Sequence Start/End
Multiple Copies and Sequencing

This section explains how to use the Repeat key to print multiple copies of a file or sequence text either numerically or alphabetically.

Press the Repeat key to make copies or sequence labels. The prompt below will appear.

Press the Repeat key to make copies or sequence labels. The prompt below will appear.

Select Copies to specify the number of copies you want to print (1-999). Use the left and right cursor keys to move the cursor to the left of Copies and press Enter. The printer displays the current setting for this option (see the following example) and waits for your entry. Press Delete to accept the number of copies shown, or type in your specific number and press Enter. Press Print.

Select Sequence to automatically generate and print labels containing a sequence of one letter or one to three numbers (101 102 103, ABC....etc.) without having to type the text of each label yourself. You simply tell the printer what characters to print on the first and last labels an how much to increment between labels (see following table).

Printing Sequential Labels

<table>
<thead>
<tr>
<th>Start</th>
<th>Stop</th>
<th>Increment</th>
<th>Individual Labels Printed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>1</td>
<td>1 2 3 4 5 6 7 8 9 10</td>
</tr>
<tr>
<td>01</td>
<td>10</td>
<td>1</td>
<td>01 02 03 04 05 06 07 08 09 10</td>
</tr>
<tr>
<td>001</td>
<td>10</td>
<td>1</td>
<td>001 002 003 004 005 006 007 008 009 010</td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>2</td>
<td>2 4 6 8 10 12</td>
</tr>
<tr>
<td>A</td>
<td>J</td>
<td>1</td>
<td>A B C D E F G H I J</td>
</tr>
<tr>
<td>a</td>
<td>z</td>
<td>4</td>
<td>a e i m q u y</td>
</tr>
</tbody>
</table>

The sequence character takes on the current character attributes previously defined. Optionally, you can redefine the sequence character’s attributes like any other character. Note: You can only define one sequence type (numeric or alpha) per document/file, but you can place the sequence character in your document/file once on each line.
Select **Sequence** from the **Repeat** menu. The **Sequence** menu will appear.

Select **Sequence** from the **Repeat** menu. The **Sequence** menu will appear.

Use the left and right cursor keys to move to the left of the option you want and press **Enter** to select it.

**Example 1**

If you choose **Alphabetic**, the printer prompts you to enter the first letter to start the sequence. Type the first letter of your choice and press **Enter**.

For our example, we have selected the letter “A”.

The printer then prompts you to enter the last letter to end the sequence. Type the last letter of your choice and press **Enter**.

The next prompt you will enter the increment amount. Press **Enter**.

You will then select **Insert** from the **Sequence** menu by pressing **Enter**. This will place the sequence where you would like it to begin. A black box will be seen where the sequence will start. See example below.

Press the **Print** key.

Wire A  Wire B  Wire C
For multiple labels, Press the **Repeat** key and the **Repeat** menu will appear. Toggle your cursor to the left of **Copies** and press **Enter** to select.

The number of copies can either be typed in or you can use your up and down cursor keys. In our example, we have selected 2 copies. Press **Enter**.

Press the **Print** key.

![Wire A  Wire A  Wire B  Wire B](image)

**Example 2**

If you choose **Numeric**, the printer prompts you to enter the first number to start the sequence. Type the first number of your choice and press **Enter**.

For our example we have selected two digits.

Enter the last number to end the sequence. Type the last number of your choice and press **Enter**.

The next prompt you will enter the increment amount. Press **Enter**.

You will then select **Insert** from the **Sequence** menu by pressing **Enter**.
A black box will be seen where the sequence will start.

1: A
2: 

Press the Print key.

Example 3

Here is another example of a numeric sequence using an increment of 2 and triple digits.

Enter the first number to start the sequence. We chose “006” for this example. Press Enter.

Sequence Start
Start: 006

Enter the last number to end the sequence. We chose “12” for this example. Press Enter.

Sequence End
End: 12

The next prompt you will enter the increment amount. Press Enter.

Sequence Inc
Inc: 2

You will then select Insert from the Sequence menu by pressing Enter. A black box will be seen where the sequence will start.

1: 
2: 

Press the Print key.

006 008 010 012
Example 4

Here is an example of using multiple pages and numeric sequencing. For our example, we have typed “Line In” on the label (Page 1).

| 1: Line In_ |
| 2: |

Press the Repeat key and select Sequence by pressing Enter. Toggle the cursor to the left of Numeric and press Enter again.

Sequence Menu
- Insert _Alpha *Num

Enter the first number to start the sequence. We chose “1” for this example. Press Enter.

Sequence Start
Start: 1

Enter the last number to end the sequence. We chose “2” for this example. Press Enter.

Sequence End
End: 2

The next prompt you will enter the increment amount. Press Enter.

Sequence Inc
Inc: 1

You will then select Insert from the Sequence menu by pressing Enter. A black box will be seen where the sequence will start.

| 1: Line In |
| 2: |

continued on page 30
To start a new page, use the **Shift** and the **Down Cursor** key to move to the next page. A prompt will appear with the page number.

We have typed “Line Out” on the label (Page 2).

Follow the same steps for the sequence setup on Page 1 and Insert the sequence. A black box will be seen where the sequence will start.

Press the **Print** key.

```
Line In 1  Line Out 1  Line In 2  Line Out 2
```
To select the **Printer Setup** press the Shift and the Print key together. The prompt below will appear. The menu options are reset, unit of measure, density, auto off, advance cut, language, printspeed and LCD contrast.

To select **Reset** to restore all factory settings and defaults. To select **Reset** press Enter or to exit press Delete.

The **Unit of Measure** function allows you to choose the unit of measure you want to use for setting label width and margin. The options are tenths of an inch (default) and millimeters. Select **Unit** from the printer setup menu by using the cursor keys and pressing Enter. The unit menu will appear. Use the arrow keys to move to the left of the option you want and press Enter. To accept the current setting press Delete.

Select **Density** to specify the density (0-7) for printing the current label. **Density** will make the label darker or lighter per unit measure. The printer displays the current density setting and waits for your entry. Press Delete to accept the value shown, or use the left cursor key to add density and press Enter.

If the characters are smeared on a label or are not completely filled in, you can attempt to fix the problem by adjusting the print density. If the characters are smeared, specify a lower number in the field; if the characters are not completely filled in, specify a higher number. You may need to adjust the density after installing a new tape.
Select **Auto Off** to activate auto shut off. The factory default is to shut off the printer after 5 minutes of non-use. When the printer is turned off, all current label text and text attributes settings are saved. All files in memory are still saved. Press **Delete** if you decide you do not wish to change the current setting. Or press **Enter** to activate auto shut off. When turned on, an asterisk will appear. By default, this function is on.

The **Advance to Cut** function advances the label material to the cut position. The default setting is advance to cut enabled. If you do not need this function you may disable the advance to cut function by using the cursor keys to move to the left of **Advance** in the printer setup menu and press **Enter**.

The **Language** function allows you to choose from 4 different languages. The default language is English. Other options are spanish, french and german. Select **Language** from the printer setup menu by using the cursor keys and press **Enter**. The language menu will appear. Use the cursor keys to move to the left of the language you want and press **Enter**. To accept the current setting press **Delete**.

<table>
<thead>
<tr>
<th>Languages Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>* English _eSpanish _Francais _Deutsch</td>
</tr>
</tbody>
</table>

**Printspeed** is the rate at which the label advances from the printer when printed. The default printspeed is unlimited. To specify a printspeed, select **PrtSpeed** from the printer setup menu by using your cursor keys and press **Enter**. The printspeed menu will appear and by using your cursor keys you can select from the options below by pressing **Enter**. To accept the current setting press **Delete**.

<table>
<thead>
<tr>
<th>PrtSpeed Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Unlimit _0.5 _0.8 _1.0</td>
</tr>
</tbody>
</table>

The **LCD Contrast** allows you to lighten or darken the LCD of your printer. Select **Lcdcontrast** from the printer setup menu by using the cursor keys and press **Enter**. The lcd contrast menu will appear. Use the right cursor to lighten or the left cursor to darken. As you use the cursors, you will see a difference in your screen. Press **Enter** to accept the your setting. To accept the current setting press **Delete**.

<table>
<thead>
<tr>
<th>LCD Contrast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Left - Right</td>
</tr>
</tbody>
</table>
Bar Codes

To print a Bar Code, press the Shift and the Font key together. Use the Bar Code Menu to specify the type of bar code you want to print.

<table>
<thead>
<tr>
<th>BARCODE Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>None _codaBar _Code39 _Ean8 _eAn13 _I2of5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BARCODE Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Upca _uPce _coDe128 _Msiplessey _pdf417</td>
</tr>
</tbody>
</table>

K4100 has ten bar codes built-in. The following table summarizes information on these bar codes. The

<table>
<thead>
<tr>
<th>Bar Code Type</th>
<th>Valid Characters</th>
<th>Checksum Options Available</th>
<th>Fixed Length</th>
<th>Special Restrictions &amp; Other Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codabar</td>
<td>0-9, A-D, $/%</td>
<td>None, mod 10, mod 16, &lt;32 characters</td>
<td></td>
<td>First and last characters must always be either A, B, C, or D. Letters not allowed in body of bar code</td>
</tr>
<tr>
<td>Code 39</td>
<td>0-9, A-Z, $/% space</td>
<td>None, mod 43, &lt;32 characters</td>
<td>Lowercase letters not allowed</td>
<td></td>
</tr>
<tr>
<td>EAN-8</td>
<td>0-9</td>
<td>EAN-8, 7, 9 or 12 digits</td>
<td></td>
<td>Length varies because of optional 2 or 5 digit supplemental</td>
</tr>
<tr>
<td>EAN-13</td>
<td>0-9</td>
<td>EAN-13, 12, 14 or 17 digits</td>
<td></td>
<td>Length varies because of optional 2 or 5 digit supplemental</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>0-9</td>
<td>None, mod 10, Even number of digits</td>
<td>Printer adds leading zero, if needed, to make the length even</td>
<td></td>
</tr>
<tr>
<td>UPC-A</td>
<td>0-9</td>
<td>None, 11, 13 or 16 digits</td>
<td></td>
<td>Length varies because of optional 2 or 5 digit supplemental</td>
</tr>
<tr>
<td>UPC-E</td>
<td>0-9</td>
<td>None, 6, 8 or 11 digits</td>
<td></td>
<td>Length varies because of optional 2 or 5 digit supplemental</td>
</tr>
<tr>
<td>Code 128</td>
<td>128 ASCII Character Set</td>
<td>None, &lt;32 characters</td>
<td>See Appendix D</td>
<td></td>
</tr>
<tr>
<td>MSI Plessey</td>
<td>0-9</td>
<td>None, mod 10, mod 11, &lt;16 characters</td>
<td>Mode 11 checksum cannot equal 10</td>
<td></td>
</tr>
<tr>
<td>PDF 417</td>
<td>All ASCII characters, 0 to 400 levels of security</td>
<td>&lt;700 characters</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

After the bar code selection has been made, press the Shift and Font keys together to go back to the Bar Code menu. The menu will change allowing you to customize the bar code selected using code, text and resolution.

<table>
<thead>
<tr>
<th>BARCODE Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code _Text _Resolution</td>
</tr>
</tbody>
</table>
Select **Code** to change the type of bar code you want to print. The printer displays the types of bar codes available. Use the left and right cursor keys to move to the left of the option you want and press **Enter**. If an asterisk displays to the left of the option, selecting it turns code off.

Depending on the bar code you have selected, some bar codes allow you to choose whether to include a checksum and change the resolution at which the bar code is printed as well as whether to print text or the checksum.

Select **Text** to print text as part of the bar code. Use the left and right cursor keys to move to the left of the option you want and press **Enter**. If an asterisk displays to the left of the option, selecting it turns text printing off. Text is printed in the following manner:

- Code 39, Code 128, Interleaved 2 of 5 and MSI Plessey: text is printed immediately beneath the symbol.
- EAN8, EAN13 and UPC: text for the number system is printed at the left of the symbol; text for the product and manufacturer code is printed beneath the symbol; text for the supplemental is drawn above the symbol.
- PDF 417 has no text option.

**Resolution** specifies whether you want to print the bar code at normal or high resolution. Use the left and right cursor keys to select the option you want and press **Enter**.

**Checksum** specifies the type of error checking you want to use. The type of bar code selected at **Code** determines the prompt that displays next. For example, if you selected 12 of 5, the following prompt displays:

Some bar code symbologies allow you to print the checksum value as part of the bar code.
File Management

To select the File Menu press the File key. Use the File Menu to create new files, open files, save files and delete files.

Select New to create a new document. The printer clears any text displayed on the screen, returns all attributes to factory defaults and displays a blank edit screen so you can enter new text. To create a New file, press the File key and select New with the Enter key. Or use Shift and File as a shortcut.

Select Open to access an existing document you want to edit or print. The printer displays a list of file(s) you have saved (see the following example) and waits for you to select the file you want to work with. Press the File key and use the cursors to scroll to the left of Open and press Enter. The Open File Menu is now displayed. Use the left and right cursor keys to scroll to the left of the file you want to open and press Enter to select it. See example below.

Select Save to save the current document. You must save the label you are working on before you select either New or Open. If you do not save first, it will be lost. Press the File key and use the cursors to scroll to the left of Save and press Enter. The Save File Menu is now displayed prompts you to enter a file name.

File names can be any combination of letters and numbers, 8 character maximum, with no punctuation or file name extensions.
If you enter a file name for an already existing file, you will see the following message:

Overwrite?
OK? (Y,N)

Press Y to overwrite or N to enter a different file name. If you decide not to save the file, simply press Delete.

Select Delete to delete files that you no longer need. Press the File key and use the cursors to scroll to the left of Delete and press Enter. The Delete File menu displays a list of files you have saved (see the following example) and waits for you to select the file you want to delete. Use the left and right cursor keys to move the cursor to the left of the file you want to delete and press Enter to select it. If you decide not to delete a file, simply press Delete.

Delete File
  Address _Job 4048 _ww
You can enter multiple labels in a file by using **Page Up** and **Page Down** to access additional pages (labels). In this case, you can think of a file as a single document containing one or more pages (labels). Each label can be up to six lines.

To start a new page while you are in a file, use the **Shift** and the **Down Cursor** key to move to the next page. A prompt will appear with the page number.

To move back to the preceding page, use **Shift** and the **Up Cursor** key. When you press the **Print** key, all pages in the file will be printed.
To select the **Time/Date Menu** press the **Shift** and **Repeat** keys together. Use the **Time/Date Menu** to print labels with

<table>
<thead>
<tr>
<th>Time/Date Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time _datE _stamP _setclOck _24Hourmode</td>
</tr>
</tbody>
</table>

**To use the Time/Date functions you must first set the real time clock with the local time and date.** This will lock the time and date into memory. This will have to be done once with the exception of summer and winter time changes.

Select **Set Clock** to enter the current time and date in the printer. Use the cursor keys to scroll to the left of **Set Clock** and press **Enter**. The prompt below will appear. Use the **Up and Down** cursor keys to scroll through the menu.

The information will be entered in the order shown here:

- Year_
- Month_
- Day_
- Hour_
- Minute_
- Second_

**Set Clock Parameters**

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>Last two digits of the year</td>
</tr>
<tr>
<td>Month</td>
<td>Number from 1 to 12</td>
</tr>
<tr>
<td>Day</td>
<td>Number from 1 to 31</td>
</tr>
<tr>
<td>Hour*</td>
<td>Number from 0 to 23</td>
</tr>
<tr>
<td>Minute</td>
<td>Number from 0 to 59</td>
</tr>
<tr>
<td>Second</td>
<td>Number from 0 to 59</td>
</tr>
</tbody>
</table>

* Hour is entered in 24 hour mode (i.e. 1PM would be entered as 13)
Select **Time** to add the current time to your label. Use the cursor keys to scroll to the left of **Time** and press **Enter**. The time will be added to the label where the cursor is positioned. The time can be formatted or deleted just as you had physically typed it in.

```
1:03:48:33PM  
2: 
```

Select **Date** to add the current date to your label. Use the cursor keys to scroll to the left of **Date** and press **Enter**. The **Date Menu** will appear offering 6 formats (mm/dd/yy, dd/mm/yy, mm/dd/yyyy, dd/mm/yyyy, dd.mm.yy, dd.mm.yyyy). Use the cursor keys to scroll to the left of the format you want and press **Enter**.

```
Date Menu
  ■ mm/dd/yy _dd/mm/yy _
```

The current date will be added to the label where the cursor is positioned. The date can be formatted or deleted just as you had physically typed it in.

```
1: 02/01/04  
2: 
```

**Note:** Do not confuse the **Time** and **Date** options with the **Stamp** option. **Time and Date** enters the current time/date into your label at the insertion point, once entered they are now considered text by the printer (as if you typed them by hand). **The Stamp function will always use the current time clock at the time of print job.**

Select **Stamp** to have the current date and time (at the time of print) printed vertically on the very edge of the label. Every time you press print a stamp with the current date and time will be printed in ddhhmmMMMyy format. Use the cursor keys to scroll to the left of **Stamp** and press **Enter**. This will turn **Stamp** on and an asterisk will be displayed. To turn it off, press **Enter** again.

```
File Backup -  
Marketing
```

**Note:** Using the stamp on tape supply sizes 0.50” and smaller is not recommended.

Select **24 Hour Mode** causes time entered in the text of a label via the **Time** option to be in 24 hour mode (i.e., 1 PM as 13). Use the cursor keys to scroll to the left of **24 Hour Mode** and press **Enter**. This will turn **24 Hour Mode** on and an asterisk will be displayed. To turn it off, press **Enter** again.
PC Operations
Introduction

The K4100 will operate either standalone or as a PC printer. This new printer will operate with Microsoft Windows 98, ME, 2000 or XP. Any standard windows application such as Word, Excel or other programs can print to the K4100 via a standard Windows printer driver.

Kroy also includes the Kroy Label Designer Software (KLDS) application with your printer that contains easy to use, preformatted templates for your printer.

The communications between your printer and your PC are controlled by a windows printer device driver.

The printer device drivers are located on the included software CD-ROM or current drivers are available at www.kroy.com
KLDS Software and Driver Installation

Installing the KLDS Software
Close all programs prior to installation. Insert the Kroy Label Designer into the CD-ROM drive. On most systems the installation program will automatically start. See the steps below to help you along with your setup.

1. The InstallShield Wizard will appear and prepare to install.
2. Kroy Label Designer Setup will appear. Click Next to continue installation.
3. The License Agreement will appear: Click Yes.
4. Choose the Destination: the default will be C:\Program\Kroy Click Next.
5. You will then choose the Setup Type. The default is Typical and is recommended for most users. Click Next.
6. Click Finish to complete.

Installing the Printer Drivers
The drivers for the KLDS will automatically setup. You will see the following prompts once the software portion is complete.

1. Do you wish to install Kroy Printers. Click Yes.
2. The Kroy Printer Driver Setup will then appear. Click Next to continue.
3. You can now select to add your Kroy Label Printer under Setup Type. Click Next to continue.
4. Select the mode of printer installation. Choose Automatic and connect the printer to your PC using the serial cable. Turn the printer on.
5. Setup will then scan the COM ports on your system for the new printer, Click Next.
6. Name your Kroy Printer and select it as your default label printer by selecting Yes. Click Next.
7. Recommended Port Setting will appear and click OK.
8. Click Finish to complete.
Creating a Label

Double click the KLDS Icon or go to your Start Menu\Programs\Kroy Label Designer and select it. The main screen will appear.

1. Go to the Label Menu and select Label Setup. Click on the K4100 printer. Click OK to verify.

2. Select the appropriate Supply Type, Size and Label Orientation that you are using in your K4100.
3. A label template will appear on the Main Menu Screen. Select the **Text Tool “A”** from the Main Tool Bar, click your left mouse button on the label template and input text at the blinking cursor.

![Label Template](image)

4. After creating your label, click on the **Print Icon** from the top tool bar, or go to the Label Menu and select **Print**. Select the number of copies and click **OK** to print your label.

![Print Dialog](image)

5. The K4100 will then print your label.

For further assistance, go to the **Help Menu** of your KLDS Software.
Downloading Fonts

Downloading a Font
The K4100 has the option of downloading fonts from the PC into your Font Menu. Follow the steps below.

1. **Connect** the serial cable to the com port of choice and to your printer.
2. Go to the **Start Menu** of your PC and go to **Settings** and select **Printers**.
3. Right click on the K4100 driver and go to **Properties**.

4. Click on **Control** and go to **Advance Options**...

5. Select **Download Fonts** from the Menu and click **Update**.
6. Go to the Font folder on the C drive of your PC and click OK.

7. Select the Font or Font Family of your choice and click OK.

8. The LCD Display of the printer will show the progress of the download using the pound sign(#) across the bottom. The printer will show a receiving and an updating display.

   Receiving...  
   ######

   Updating...  
   #######

9. The download is now complete and you can find the font in your Font Menu. Press the Delete key to accept the current Block font or use the left and right cursor keys to move the cursor to the left of the font you want and press Enter to select it.
You may also use other Windows applications to create labels with the K4100 printer. This is an example using Microsoft Word to create a label.

1. Click on the **File** menu and select **Print**.

   ![Print dialog box]

2. Select the Kroy K4100 Label Printer in the drop down box and Click **Close**.

3. Click on the **File Menu** and select **Page Setup**.

   ![Page Setup dialog box]

4. Click on the **Paper Size** tab and select the supply type. This size should match the size of the width on the supply cartridge currently installed in your K4100 printer. Usually you will want **Landscape** orientation selected.
5. Select the **Margins** tab and change the top, bottom, left, right, gutter, header and footer to “0” or desired margin values. The default margins must be changed since you are not printing to a full 8.5” x 11” page. For some media, Word will want to “Fix” the margins based on the maximum printable area of the media selected. In this case, 1” tape requires a 0.05” top and bottom margin. Click on **OK**.

![Page Setup dialog box](image)

6. It is recommended to click on the **View** menu and select **Page Layout** mode.

7. A blank label template with a blinking cursor will appear on your PC monitor.

8. Enter the label text.

![Microsoft Word window](image)

9. Select **Print** from the File menu. Make sure that the K4100 is selected and Click **OK** to print the label. **Note:** *When printing and the cartridge runs out of tape, remove and install a new cartridge, and press Feed to continue printing. DO NOT TURN OFF THE PRINTER.*

To **Save** your label, go to the **File** menu and select **Save**. You can also save the document as a template to start other label files.
Appendix A: Maintaining Your Printer

The printer requires no lubrication and only minimal maintenance. Occasional cleaning of the exterior surfaces and regular cleaning of the printhead and rollers are all that is required. This appendix explains how to clean these parts of your printer.

Cleaning the Printhead and Rollers
The printhead and rollers should be cleaned after every cartridge. Use isopropyl 90% alcohol on a soft cotton swab to remove adhesive buildup and tape and ribbon residue. Make sure the alcohol has evaporated before loading a supply cartridge.

Note: Avoid touching the surface of the printhead with your finger. Acids and oils on your skin will damage the printhead.
Appendix B: System Messages

The following are system messages that the K4100 will display and an explanation of each message.

**Cannot Save**
(1) There is not enough memory to save your file.

**No Memory**
Either delete unneeded files or simplify labels by reducing the amount of text or the number of formatting options they contain.
(2) You tried to save a file to drive B when it is write protected.

**Cartridge Empty**
Cartridge supply is empty. Install a new cartridge.

**Font Size Too Big**
The point size is too large for the number of lines you have entered. Reduce the point size or select fewer lines.

**Size Too Small**
Auto size has calculated a size smaller than the minimum size of 4 pt.

**Font Error!**
You entered the wrong number of characters for the bar code. Check the requirements for the type of bar code you are using and enter the correct number of characters.

**No Cartridge**
Install a cartridge in order to print.

**No Files Found**
You selected Open or Delete but have no files saved in memory. You must save files before you can open or delete them.

**Printer Too Hot**
The printer is too hot to print labels. Wait about five minutes and then resume printing. This message may also appear when the printer is used in an ambient temperature below its minimum rated operating temperature.

**Printing...**
The printer is printing labels. No action required.
# Appendix C: Troubleshooting

This appendix explains how to solve some common problems that may arise when you are using the printer. If you are unable to correct the problem contact your Dealer or Kroy Customer Service. In the United States, call (800)347-5769; in Europe call +44-(0)118-986-5200.

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| Display stays black/blank after printer is turned on | • Adjust the LCD Contrast  
• Make sure the AC Adapter is firmly connected |
| Printer does not print | • Ensure the lock/release knob is in the locked position  
• Check the supply cartridge and its position  
• Check that the AC adapter and/or serial cable is firmly connected |
| Printed characters are not formed properly | • Adjust the print density  
• Clean the printhead and rollers |
| Printed characters have a line through them and/or voids | • Turn off printer and use a Kroy Cleaning Kit (Part#255900) or use 90% or better isopropyl alcohol on a cotton swab to clean the printhead and rollers (See Appendix A) for instructions. |
| Printer isn't working properly | • Reset the printer  
• Turn the printer on and off |
| Printer has locked up | • Turn the printer on and off |
Appendix D: Updating Firmware

Updating Firmware
Updates for firmware can be found at www.kroy.com. Go to support and click on downloads.

1. **Connect** the serial cable to your Com port of choice and to your printer.
2. **Download** the updated file from our site.
3. **Save** the file to your PC.
4. Go to your **Start Menu** of your PC and go to **Settings** and select **Printers**.
5. Right click on the K4100 driver and go to **Properties**.

6. Click on **Control** and go to **Advance Options**...

7. Select **Download Firmware** from the menu and click **Update**.

8. A warning will appear below and click **Yes** to continue.
9. Select the firmware file and click **Open**.

10. The printer will then update the file.

   The LCD Display will show the progress of the download using the pound sign (#) across the bottom. The printer will show a receiving and an updating display.

   ![Receiving... ######](image)

   ![Updating... ######](image)

9. The download is now complete.
Appendix E: Using Accent Characters

K4100 has a variety of international characters and symbols found in **Blue** on the keypad. Use the **Alt** key + the accent character and/or symbol to print out these special accent characters.

In our example, we will use the ´ accent character and add it to the letter “i” in “Factoría” (Factory).

The “i” in “Factoría” must be accented. To do this, you will hold down the **Alt** + **u** key on the keypad. This activates the accent character. You will then press the letter “I” on the keypad. The printer will then display the accented character in the text of the label.

1:Factoría _
2:

Accent Character Guide

<table>
<thead>
<tr>
<th></th>
<th>aAeEiIoOuU</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>aAnNoO</td>
</tr>
<tr>
<td>~</td>
<td>aAeEiIoOuY</td>
</tr>
<tr>
<td>`</td>
<td>aAeEiIoOuU</td>
</tr>
<tr>
<td>-</td>
<td>aAeEiIoOuUyY</td>
</tr>
</tbody>
</table>

E-1
The K4100 has the capability to accept code to print characters not found on the keyboard. To use the character map, the **Extended Mode** must be on. To turn the **Extended Mode** on press the Alt and Space Bar together. To turn this mode off, press the Alt and Space Bar together again. See the character set below for ASCII codes to assist you.

To enter characters in extended mode, enter the 4 digit code shown in the table below. Most of the characters will be properly displayed on the LCD. For some characters, a solid block place holder will display on the LCD, but the selected character will print on the label.

<table>
<thead>
<tr>
<th>ASCII Code</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>0123</td>
<td>{</td>
</tr>
<tr>
<td>0124</td>
<td></td>
</tr>
<tr>
<td>0125</td>
<td>}</td>
</tr>
<tr>
<td>0126</td>
<td>~</td>
</tr>
<tr>
<td>0140</td>
<td>Æ</td>
</tr>
<tr>
<td>0156</td>
<td>œ</td>
</tr>
<tr>
<td>0159</td>
<td>Ŷ</td>
</tr>
<tr>
<td>0162</td>
<td>ç</td>
</tr>
<tr>
<td>0163</td>
<td>£</td>
</tr>
<tr>
<td>0165</td>
<td>¥</td>
</tr>
<tr>
<td>0168</td>
<td>“</td>
</tr>
<tr>
<td>0176</td>
<td>°</td>
</tr>
<tr>
<td>0177</td>
<td>±</td>
</tr>
<tr>
<td>0180</td>
<td>‘</td>
</tr>
<tr>
<td>0191</td>
<td>ţ</td>
</tr>
<tr>
<td>0192</td>
<td>Ā</td>
</tr>
<tr>
<td>0193</td>
<td>Ī</td>
</tr>
<tr>
<td>0194</td>
<td>Å</td>
</tr>
<tr>
<td>0195</td>
<td>Ã</td>
</tr>
<tr>
<td>0196</td>
<td>Å</td>
</tr>
<tr>
<td>0197</td>
<td>Å</td>
</tr>
<tr>
<td>0198</td>
<td>Æ</td>
</tr>
<tr>
<td>0199</td>
<td>Ç</td>
</tr>
<tr>
<td>0200</td>
<td>É</td>
</tr>
<tr>
<td>0201</td>
<td>É</td>
</tr>
<tr>
<td>0202</td>
<td>É</td>
</tr>
<tr>
<td>0203</td>
<td>É</td>
</tr>
<tr>
<td>0204</td>
<td>í</td>
</tr>
<tr>
<td>0205</td>
<td>í</td>
</tr>
<tr>
<td>0206</td>
<td>ũ</td>
</tr>
<tr>
<td>0207</td>
<td>í</td>
</tr>
<tr>
<td>0208</td>
<td>Ð</td>
</tr>
<tr>
<td>0209</td>
<td>Ñ</td>
</tr>
<tr>
<td>0210</td>
<td>Ô</td>
</tr>
<tr>
<td>0211</td>
<td>Ø</td>
</tr>
<tr>
<td>0212</td>
<td>Ō</td>
</tr>
<tr>
<td>0213</td>
<td>Ō</td>
</tr>
<tr>
<td>0214</td>
<td>Ō</td>
</tr>
<tr>
<td>0215</td>
<td>×</td>
</tr>
<tr>
<td>0216</td>
<td>Ø</td>
</tr>
<tr>
<td>0217</td>
<td>Ù</td>
</tr>
<tr>
<td>0218</td>
<td>Ù</td>
</tr>
<tr>
<td>0219</td>
<td>Ù</td>
</tr>
<tr>
<td>0220</td>
<td>Ù</td>
</tr>
<tr>
<td>0221</td>
<td>Ù</td>
</tr>
<tr>
<td>0222</td>
<td>þ</td>
</tr>
<tr>
<td>0223</td>
<td>ß</td>
</tr>
<tr>
<td>0224</td>
<td>à</td>
</tr>
<tr>
<td>0225</td>
<td>á</td>
</tr>
<tr>
<td>0226</td>
<td>â</td>
</tr>
<tr>
<td>0227</td>
<td>â</td>
</tr>
<tr>
<td>0228</td>
<td>â</td>
</tr>
<tr>
<td>0229</td>
<td>â</td>
</tr>
<tr>
<td>0230</td>
<td>ae</td>
</tr>
<tr>
<td>0231</td>
<td>ç</td>
</tr>
<tr>
<td>0232</td>
<td>è</td>
</tr>
<tr>
<td>0233</td>
<td>é</td>
</tr>
<tr>
<td>0234</td>
<td>ì</td>
</tr>
<tr>
<td>0235</td>
<td>ë</td>
</tr>
<tr>
<td>0236</td>
<td>ì</td>
</tr>
<tr>
<td>0237</td>
<td>í</td>
</tr>
<tr>
<td>0238</td>
<td>î</td>
</tr>
<tr>
<td>0239</td>
<td>ï</td>
</tr>
<tr>
<td>0240</td>
<td>ô</td>
</tr>
<tr>
<td>0241</td>
<td>ñ</td>
</tr>
<tr>
<td>0242</td>
<td>ò</td>
</tr>
<tr>
<td>0243</td>
<td>ò</td>
</tr>
<tr>
<td>0244</td>
<td>ò</td>
</tr>
<tr>
<td>0245</td>
<td>ò</td>
</tr>
<tr>
<td>0246</td>
<td>ò</td>
</tr>
<tr>
<td>0247</td>
<td>+</td>
</tr>
<tr>
<td>0248</td>
<td>ø</td>
</tr>
<tr>
<td>0249</td>
<td>û</td>
</tr>
<tr>
<td>0250</td>
<td>ú</td>
</tr>
<tr>
<td>0251</td>
<td>û</td>
</tr>
<tr>
<td>0252</td>
<td>ü</td>
</tr>
<tr>
<td>0253</td>
<td>ý</td>
</tr>
<tr>
<td>0254</td>
<td>þ</td>
</tr>
<tr>
<td>0255</td>
<td>ÿ</td>
</tr>
</tbody>
</table>